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This Polycom® iPower™ multimedia conferencing system software release 
bulletin provides information about software Version 6.2.0. This document 
includes the following topics: 

 Product Description 

 Enhancements in This Release 

 Compatible Communications Products 

 Restrictions and Recommendations 

 Additional Information 

 Installing Version 6.2 Software on the iPower Systems 

Product Description 
The iPower system is a state-of-the-art multimedia conferencing system 
incorporating the Polycom iPower architecture. This architecture offers 
unique capabilities that simplify the inclusion of information in a meeting 
and make it easier to manage both the system and the network it runs on. 
The iPower system performs as a multi-purpose conferencing system that 
can be used both on and off a call. For more information, go to 
www.polycom.com. 

 



Enhancements in Version 6.2 
Version 6.2 enhancements include: 

 H.264 Video Error Concealment enhances your video experience by 
diminishing freezing video. The encoder enhancements implemented on 
the iPower systems:  
– Minimize the chance that the display wil freeze 

– Conceal errors 

– Reduce full-frame refreshes 

 IP calls dialed from a Global Address Book on a Global Management 
System will now select the E.164 address of the far site system. 

 A call rate of 1152 kbps is now available for IP calls. 

 The maximum number of digits allowed for ISDN dialing has been 
increased to 30 to ensure compatibility with all international dialing 
requirements. 

 Far-end camera control is now available on calls through a RADVISION 
L2W-323 Gateway. 

 Internal Multipoint calls can now be placed when the system is behind 
certain NAT environments. 

 

Enhancements also include Closed Captioning capabilities: 

 The iPower system can now display captions sent from another iPower 
or Viewstation site as part of a video conference. Users can specify 
whether to display captions for a video conference, and they can also 
specify which monitor to use for displaying the captions. The Closed 
Captioning feature is compatible with the ITU-T T.140 standard. 

 The Closed Captioning option lets you receive captions from a captioning 
service provider and send captions to other sites in a conference. For 
more information about this option, go to: 
http://www.polycom.com/products_services/0,,pw-35-6032,00%2Ben-
USS_01DBC.html. 

 Viewers of streamed video via the People+Content Streaming feature 
are now able to view captions. 

Enhancements in Version 6.0 
Version 6.0 enhancements include: 

 Standards-based H.264 and Polycom H.264* are now available on all 
iPower platforms. Support for H.264 meets the ITU-T specification. The 
iPower systems interoperate over IP and ISDN with ViewStationFX, 
ViewStationEX, Viewstation4000, VSX, and with other H.264 standard 
compliant systems. 

 Optional standards-based AES encryption is now available for point-to-
point calls over IP networks. iPower provides AES encryption as 

 



specified in H.235v3. Activating encryption does not affect the call 
speeds that iPower systems support — encrypted calls work at all the 
rates that unencrypted calls do. AES encryption is not supported for 
internal multipoint calls or ISDN calls. If you acquired your system 
before January 1, 2004, you must purchase a license key in order to use 
the AES Encryption option. See below for more information.  

 People video can now be displayed at resolutions of 4CIF/4SIF. You see 
crisper images with resolutions equivalent to PAL/NTSC, though frame 
rates are lower.  

 Content video can now be displayed with H.264 compression up to XGA 
resolution. In point-to-point calls between iPower systems, you can 
display Content with crisp resolution more quickly and with a higher 
frame rate than is possible when using H.263. This feature includes 
patent-pending technology. 

 You can now choose to transmit VCR and Document Camera inputs as 
People video. Use AdminTools to configure these sources. 

AES Encryption 

In IP calls that do not use the internal multipoint option, iPower supports 
AES encryption as specified in H.235v3. AES encryption is not supported 
for internal multipoint calls or ISDN calls. 

When configured for encryption, iPower will encrypt audio, People video, 
Content video and H.224 data (used for far end camera control), provided 
that the far end supports this.  iPower does not encrypt T.120 data or 
streamed media.  

iPower offers three modes for encryption: 

 Disabled: The system will not encrypt calls, even if the far end 
supports encryption. 

 When Available: The system will encrypt calls if the far-end system 
supports encryption; unencrypted calls will still connect successfully.  
Note that integrated T.120 data sharing is disabled when you choose 
this setting. 
When you chose this setting, iPower will allow internal multipoint and 
ISDN calls, but will first warn the user that these calls are not 
encrypted.  The system will also allow streaming, but it will warn the 
user that the streamed media is not encrypted.  

 Required: The system does not complete unencrypted calls. If you 
make a call and the far-end system does not support encryption, the 
call does not connect. Note that integrated T.120 data sharing and 
internal multipoint calls are disabled when you choose this setting. 
When you chose this setting, iPower will allow ISDN calls, but will first 
warn the user that these calls are not encrypted. The system will also 
allow streaming but it will warn the user that the streamed media is not 
encrypted. 

iPower considers a call successfully encrypted if all transmit and receive 
audio, video and H.224 channels are encrypted. In any of these channels 

 



are not encrypted, iPower does not consider the overall call encrypted.  In 
a successfully encrypted call, iPower displays a lock icon on the status bar; 
if the call did not fully encrypt (or if encryption was not configured) iPower 
will not display any encryption-related icons. In all calls, Conference 
Statistics and Operating Statistics will report the overall encryption status 
and the encryption status of each audio, video and H.224 channel. 

When troubleshooting encryption related problems, keep in mind that 
equipment between the two endpoints of the call such as gatekeepers that 
use “routed signaling”, gateways and MCUs also need to support 
encryption. 

The iPower system's encryption messages refer only to the encryption 
provided by the iPower system. The system cannot detect external 
encryption. 

Compatible Communications Products 
The iPower multimedia conferencing system is tested extensively with a 
wide range of products. The following list is not a complete inventory of 
compatible equipment; it simply indicates the products that have been 
tested for compatibility with this release. 

Note: Visual collaboration systems use a variety of algorithms to 
compress audio and video. In a call between two systems, each 
end transmits audio and video using algorithms supported by the 
other end. In some cases, a system may transmit a different 
algorithm than it receives. This process occurs because each 
system independently selects the algorithms it considers best for 
a particular call. At times, different products make different 
(though reasonable) choices. This process should not affect the 
quality of the call. 

Compatible Conferencing Equipment 
 Aethra Vegastar Gold 4.01.0016 

 Intel TeamStation™ Version 5.0a 

 iPower 600/900/9000 Collaboration System Version 5.3.0, 6.0, 6.1 

 Microsoft NetMeeting Version 3.01 
– Under most circumstances, the system will negotiate to QCIF for 

calls to NetMeeting systems. 

 Polycom PathNavigator Versions 5.1.0, 5.2.0 

 Polycom MGC-25™ version 5.5 

 Polycom MGC-25™, MGC-50™ and MGC-100™ Multipoint Conferencing 
Unit (MCU) Versions 6.02.4 
– Do not configure MGC conferences that include iPower endpoints for 

 



"dynamic FECC". 

– The Polycom Version 4.0 MGC-50 and MGC-100 MCUs do not 
support far-end camera control or browsing.  

– DO NOT attempt to run versions of the Polycom MGC-100 MCU lower 
than 2.2 with iPower Multimedia conferencing systems. 

– You may experience poor quality when sending Content in a LAN call 
using a Polycom MGC-50 or MGC-100 MCU running Version 4.00 or 
lower. To address this issue, use version 4.01 of the Polycom MGC-
50 or MGC-100 MCU. 

– You may experience problems with application sharing in a 
conference using a Polycom MGC-50 or MGC-100 MCU running 
Version 4.00 or lower. To address this issue, use version 4.01 of the 
Polycom MGC-50 or MGC-100 MCU. 

– When you use iPower Control Protocol to make calls from a LAN 
system to an ISDN system: 

o All prefixes and suffixes required by the gateway must be 
configured through AdminTools 

o The iCP Command must set the Calltype to Gateway 

 Polycom PVX Version 6.0.1 

 Polycom V500 Version 7.0.1 

 Polycom ViaVideo™ Version 5.1, 6.0.1  

 Polycom ViewStation 4000/EX/FX Version 6.0 

 Polycom ViewStation MP/SP Version 7.5.2 

 Polycom VSX 3000 Version 7.0.1 

 Polycom VSX 7000 Version 5.1.1, 7.0.1 

 Polycom VSX 8000 Version 7.0.1 

 RADVISION ViaIP ECS Gatekeeper Version 3.2 
– RADVISION gatekeepers configured for H.245 gatekeeper-routed 

signaling do not support calls from iPower systems. The gatekeeper 
must be configured for direct signaling or for gatekeeper-routed 
Q.931 signaling.  

 RADVISION BRI/PRI On-LAN L2W-323 Gateway Revision 2.2.3.25 
– Calls through a RADVISION gateway at 2x64 kbps must include an 

asterisk (*) suffix to the number dialed. Without this suffix, the call 
connects to the far end at 1x64 kbps. 

 RADVISION MCU-323/20 Version 2.2.1.0  

 Sony 6000 5.01 

 T120 does not work in H.320 calls with Sony PCS 6000. 

 Sony PCS1 2.01 

 iPower may received poor quality video in H.323 calls with Sony 
PCS-1 that use H.263+. To work around this issue, configure the 
Sony system for H.263 or H.264. 

 Tandberg 880 Versions E3.0 and E3.1 

 



 Tandberg supports H.264 at CIF resolution.  Calls with Tandberg that 
use H.264 will down-scale Content sources (such as the Windows 
desktop) to CIF resolution, with a resulting loss of video quality and 
sharpness.  To work around this issue, configure the iPower system 
to use H.263+ video. 

 Tandberg 6000 Version E3.0 

 Vcon Media Connect 8000 4.6 

 Vtel Galaxy version 2.2.0.70 

Internal Multipoint Option Compatible Products 

Internal Multipoint compatibility has been tested and found to be 
interoperable with the following products:  

 iPower 600/900/9000 Collaboration System Version 5.3.0, 6.1.0 

 Polycom PathNavigator Version 5.1.0, 5.2.0 

 Polycom PVX Version 6.0.1 

 Polycom ViaVideo™ Version 5.1, 6.0.1 

 Polycom ViewStation 512 Version 7.2 

 Polycom ViewStation 4000/EX/FX Version 6.0 

 Polycom ViewStation MP/SP Version 7.5.2 

 Polycom VSX 3000 Version 7.0.1 

 Polycom VSX 7000 Version 5.1.1, 7.0.1 

 Polycom VSX 8000 Version 7.0.1 

 RADVISION ViaIP ECS Gatekeeper Version 3.2 

Compatible Network Interface Equipment 

This section contains information on terminal adapter compatibility. The 
following products are compatible with this release of the iPower 
multimedia conferencing system:  

 Lucent/Ascend VSX Version +4.5Cp15+ 

 Promptus/DICA Hotlink Version 1.50V4 

 Madge 20™ Version 5.20.1.17 

 



Restrictions and Recommendations 

This section lists the current restrictions in the following areas: 

 General 

 Security 

 Global Management System 

 PathNavigator Call Processing Server 

 Software Configuration 

 Logging On and Logging Off 

 Audio 

 Video 

 Recording 

 Calling 

 Internal Multipoint Option 

 WebRemote 

 Hardware 

 iPower Applications 

 Third-Party Applications 

 Localization 

 Data Collaboration 

General 
 iPower cannot receive a snapshot (still image graphic) in a call that 

supports People and Content. 

 The iPower 9000 system does not support Windows Standby mode, even 
though it is listed as an option in the Windows Shutdown menu.  

 Use the Shutdown menu to power off the iPower 9000 system. Do not 
press the front panel power button to perform a shutdown.   

 If you set a password for accessing a streamed conference and then 
click the Set button to view or alter conference settings, the password is 
deleted. Users can then access the stream without supplying a 
password. To avoid this, be sure to reset the password after you open 
the Stream to Web dialog box.  

 Names for streamed conferences cannot include special characters other 
than @, ! or _ (underscore). If you use special characters in a streamed 
conference’s name, remote users who use a web browser to view the 
conference see the embedded media player with no video.  

 Recorded streams can quickly take up large amounts of hard disk space. 
When you record streams to the system’s C drive, monitor the available 
hard disk space to ensure that the system has adequate free disk space 
for proper operation.  

 



 If you change the screen resolution while the iPower application is 
running, the system experiences a “blue screen” crash.  

Security 
 Starting in version 5.0, only Integrated Windows Authentication is 

enabled on the WebRemote web server by default. Basic Authentication 
is not enabled in the default configuration. Note that this is a change 
from previous software versions, which enabled both Basic 
Authentication and Integrated Authentication security levels by default. 

Using Windows Integrated Windows Authentication alone provides 
greater security, but it also prevents browsers other than Internet 
Explorer from using WebRemote. Using Integrated Windows 
Authentication alone also causes problems in environments that do not 
fully support it.  For more information on configuring WebRemote's 
security options, see Configuring Web Remote Security, available in the 
Security Center at www.polycom.com.  

 You should ensure the security of your system by taking the following 
precautions: 
– Make sure that all accounts use effective passwords, especially those 

with administrative privileges. 

– Install, update, and use anti-virus software. 

– Install the latest security updates for Windows and for any 
applications you install.  

– Activate auditing for Windows events and monitor the audit log. 

– Restrict anonymous logins. 

– Conduct periodic reviews of your system. The Microsoft Baseline 
Security Analyzer (available free at 
http://www.microsoft.com/technet/Security/tools/default.mspx) can 
aid you in this review. 

– Check with your network administrator for security procedures. 

 Based on the Windows 2000 features used by the iPower software, 
Polycom strongly recommends that you install the following service 
packs  

– Windows 2000 Professional Service Pack 3 

– Internet Explorer 6 Service Pack 1 or Internet Explorer 5.5 Service 
Pack 2 

 



 In addition, Polycom strongly recommends that you install the following 
security patches: 

   Factory-installed on these systems:

This bulletin: Available at: Fixes this problem: 4.2.0 5.0.0 5.2.0 6.0.0 6.2.0 

MS01-029 http://www.microsoft.com/technet/ 
security/bulletin/MS01-029.asp 

Windows Media Player .ASX Processor 
Contains Unchecked Buffer 

Yes Yes Yes Yes Yes 

MS02-008 http://www.microsoft.com/technet/ 
security/bulletin/MS02-008.asp 

XMLHTTP Control Can Allow Access to 
Local Files 

Yes Yes Yes Yes Yes 

MS02-032 http://www.microsoft.com/technet/ 
security/bulletin/MS02-032.asp 

26 June 2002 Cumulative Patch for 
Windows Media Player (Q320920) 

Yes Yes Yes Yes Yes 

MS02-042 http://www.microsoft.com/technet/s
ecurity/bulletin/MS02-042.asp 

Flaw in Network Connection Manager 
Could Enable Privilege Elevation 
(Q326886) 

Yes Yes Yes Yes Yes 

MS02-045 http://www.microsoft.com/technet/ 
security/bulletin/MS02-045.asp

Unchecked Buffer in Network Share 
Provider Can Lead to Denial of Service 
(Q326830) 

Yes Yes Yes Yes Yes 

MS02-048 http://www.microsoft.com/technet/ 
security/bulletin/MS02-048.asp

Flaw in Certificate Enrollment Control 
Could Allow Deletion of Digital 
Certificates (Q323172) 

Yes Yes Yes Yes Yes 

MS02-050 http://www.microsoft.com/technet/ 
security/bulletin/MS02-050.asp 

Certificate Validation Flaw Could Enable
Identity Spoofing (Q328145) 

Yes Yes Yes Yes Yes 

MS02-055 http://www.microsoft.com/technet/ 
security/bulletin/ MS02-055.asp 

Unchecked Buffer in Windows Help 
Facility Could Enable Code Execution 
(Q323255) 

No Yes Yes Yes Yes 

MS02-062 http://www.microsoft.com/technet/ 
security/bulletin/ MS02-062.asp 

Cumulative Patch for Internet 
Information Service (Q327696) 

No Yes Yes Yes Yes 

MS02-063 http://www.microsoft.com/technet/s
ecurity/bulletin/MS02-063.asp 

Unchecked Buffer in PPTP 
Implementation Could Enable Denial of 
Service Attacks (Q329834) 

No No Yes Yes Yes 

MS02-065 http://www.microsoft.com/technet/ 
security/bulletin/ MS02-065.asp 

Buffer Overrun in Microsoft Data Access
Components Could Lead to Code 
Execution (Q329414) 

No Yes Yes Yes Yes 

MS02-070 http://www.microsoft.com/technet 
/security/bulletin/ MS02-070.asp 

Flaw in SMB Signing Could Enable 
Group Policy to be Modified (309376) 

No Yes Yes Yes Yes 

MS03-008 http://www.microsoft.com/technet/ 
security/bulletin/MS03-008.asp 

Flaw in Windows Script Engine Could 
Allow Code Execution (814078) 

No No Yes Yes Yes 

MS03-010 http://www.microsoft.com/technet/ 
security/bulletin/MS03-010.asp 

Flaw in RPC Endpoint Mapper Could 
Allow Denial of Service Attacks 
(331953) 

No No Yes Yes Yes 

MS03-011 http://www.microsoft.com/technet/ 
security/bulletin/MS03-011.asp 

Flaw in Microsoft VM Could Enable 
System Compromise (816093) 

No No Yes Yes Yes 

MS03-013 http://www.microsoft.com/technet/s
ecurity/bulletin/MS03-013.asp 

Buffer Overrun in Windows Kernel 
Message Handling could Lead to 
Elevated Privileges (811493) 

No No Yes Yes Yes 

MS03-017 http://www.microsoft.comtechnet/se Flaw in Windows Media Player Skins No No Yes Yes Yes 

 



   Factory-installed on these systems:

This bulletin: Available at: Fixes this problem: 4.2.0 5.0.0 5.2.0 6.0.0 6.2.0 

curity/bulletin/MS03-017.asp Downloading could allow Code 
Execution (817787) 

MS03-023 http://www.microsoft.com/technet/s
ecurity/bulletin/MS03-023.asp 

Buffer Overrun In HTML Converter 
Could Allow Code Execution (823559) 

No No Yes Yes Yes 

MS03-024 http://www.microsoft.com/technet/s
ecurity/bulletin/MS03-024.asp 

Buffer Overrun in Windows Could Lead 
to Data Corruption (817606) 

No No Yes Yes Yes 

MS03-025 http://www.microsoft.com/technet/s
ecurity/bulletin/MS03-025.asp 

Flaw in Windows Message Handling 
through Utility Manager Could Enable 
Privilege Elevation (822679) 

No No Yes Yes Yes 

MS03-030 http://www.microsoft.comtechnet/se
curity/bulletin/MS03-030.asp 

Unchecked Buffer in DirectX Could 
Enable System Compromise (819696) 

No No Yes Yes Yes 

MS03-039 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-039.asp 

Buffer Overrun In RPCSS Service Could 
Allow Code Execution (824146) 

No No No Yes Yes 

MS03-041 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-041.asp 

Vulnerability in Authenticode 
Verification Could Allow Remote Code 
Execution (823182) 

No No No Yes Yes 

MS03-042 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-042.asp 

Buffer Overflow in Windows 
Troubleshooter ActiveX Control Could 
Allow Code Execution (826232) 

No No No Yes Yes 

MS03-044 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-044.asp 

Buffer Overrun in Windows Help and 
Support Center Could Lead to System 
Compromise (825119) 

No No No Yes Yes 

MS03-045 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-045.asp 

Buffer Overrun in the ListBox and in 
the ComboBox Control Could Allow 
Code Execution (824141) 

No No No Yes Yes 

MS03-049 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS03-049.asp 

Buffer Overrun in the Workstation 
Service Could Allow Code Execution 
(828749) 

No No No Yes Yes 

MS04-003 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-003.mspx 

Buffer Overrun in MDAC Function Could 
Allow Code Execution (832483) 

No No No Yes Yes 

MS04-004 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-004.mspx 

Cumulative Security Update for 
Internet Explorer (832894) 

No No No Yes Yes 

MS04-007 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-007.mspx 

ASN.1 Vulnerability Could Allow Code 
Execution (828028) 

No No No Yes Yes 

MS04-011 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-011.mspx 

Security Update for Microsoft Windows 
(835732) 

No No No Yes No 

MS04-012 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-012.mspx 

Cumulative Update for Microsoft 
RPC/DCOM (828741) 

No No No Yes No 

MS04-016 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-016.mspx 

Vulnerability in DirectPlay Could Allow 
Denial of Service (839643) 

No No No Yes No 

MS04-019 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-019.mspx 

Vulnerability in Utility Manager Could 
Allow Code Execution (842526) 

No No No Yes No 

 



   Factory-installed on these systems:

This bulletin: Available at: Fixes this problem: 4.2.0 5.0.0 5.2.0 6.0.0 6.2.0 

MS04-020 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-020.mspx 

Vulnerability in POSIX Could Allow 
Code Execution (841872) 

No No No Yes No 

MS04-022 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-022.mspx 

Vulnerability in Task Scheduler Could 
Allow Code Execution (841873) 

No No No Yes No 

MS04-023 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-023.mspx 

Vulnerability in HTML Help Could Allow 
Code Execution (840315) 

No No No Yes No 

MS04-024 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-024.mspx 

Vulnerability in Windows Shell Could 
Allow Remote Code Execution (839645)

No No No Yes No 

MS04-025 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-025.mspx 

Cumulative Security Update for 
Internet Explorer (867801) 

No No No Yes No 

MS04-028 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-028.mspx 

Buffer Overrun in JPEG Processing 
(GDI+) Could Allow Code Execution 
(833987) 

No No No Yes No 

MS04-030 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-030.mspx 

Vulnerability in WebDAV XML Message 
Handler Could Lead to a Denial of 
Service (824151) 

No No No Yes No 

MS04-031 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-031.mspx 

Vulnerability in NetDDE Could Allow 
Remote Code Execution (841533) 

No No No Yes No 

MS04-032 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-032.mspx 

Security Update for Microsoft Windows 
(840987) 

No No No Yes No 

MS04-037 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-037.mspx 

Vulnerability in Windows Shell Could 
Allow Remote Code Execution (841356)

No No No Yes No 

MS04-038 http://www.microsoft.com/technet/s
ecurity/Bulletin/MS04-038.mspx 

Cumulative Security Update for 
Internet Explorer (834707) 

No No No Yes No 

 

Note: iPower systems use the multi-language version of Windows 2000 
Professional. When you download language-specific Microsoft patches, 
always use the English-language version even if you run your system in 
another language. 

For up-to-date information about security issues that affect iPower 
products, go to the Polycom Security Center at www.polycom.com. 

Global Management System 

The Global Management System uses the serial number as a unique key to 
identify the system. When iPower systems are managed by a Global 
Management System, their serial numbers must be properly configured.  

 Make sure that no two systems are configured to use the same serial 
number. The serial number is printed on the back of the iPower system 

 



computer unit. Enter the serial number in the Setup Wizard as indicated 
during the installation process.  

 You must restart the iPower system if you change the serial number (for 
example, if you originally entered an invalid serial number). Otherwise, 
you cannot use the Page System Administrator feature, and the Call 
Status indicator does not display on the Global Management System 
server.  

 Users of Norton AntiVirus software must temporarily disable NAV script 
blocking prior to registering iPower systems with GMS. Failure to do so 
will activate a GMS error message, “Manager URL Not Set”, and will 
prevent the GMS address from saving in the GMS Station field.  

To register NAV systems with GMS, do the following: 

1. Disable script blocking in Norton AntiVirus. 

2. Reboot the iPower system. 

3. Launch the iPower Collaboration software. 

4. Use AdminTools to register the system with GMS.  

5. Once the system is successfully registered you may re-enable NAV 
script blocking. 

PathNavigator Call Processing Server 
 If you make a configuration change on PathNavigator (such as enabling 

Conference on Demand), you must restart the iPower system for the 
new setting to take effect.  

 The default profile as defined in PathNavigator Conference on Demand 
includes the line rate, the T.120 rate, and video session information. In 
this release, you cannot modify this information. 

Configuring the iPower system to use PathNavigator 
Conference on Demand 

To configure PathNavigator Conference on Demand, do the following: 

1. Start AdminTools and click  LAN. 

2. Click the Gatekeeper Setup tab. 

3. Check the Use a gatekeeper check box. 

4. In the Gatekeeper DNS name or IP address field, enter the 
PathNavigator gatekeeper DNS name or IP address. 

5. Enter the video call alias and voice call alias in the appropriate fields, 
and click Apply. 

Note that the video call and voice call aliases must be unique. 

6. The Use ISDN to initiate multipoint calls from this system check 
box appears.  

Check this box if you want to enable ISDN Callback. This feature allows 
the system initiating the Conference on Demand call to connect to the 

 



conference using ISDN. 

7. Click OK. 

8. Configure PathNavigator for Conference on Demand. For details, see the 
PathNavigator documentation. 

Placing a call using PathNavigator Conference on Demand 

To place a call using PathNavigator Conference on Demand, do the 
following: 

1. From the iPower collaboration application, click the Make a Call button 
and then click Directory. 

2. Check the box next to each number that you want to dial.  

The numbers appear in the Selected names field at the bottom of the 
screen. You can select as many numbers as your bridge supports.  

3. Click OK to place the call.  

If you are placing a multipoint call and have enabled ISDN Callback, you 
receive a message from the system indicating that the current call will 
be disconnected. Click OK when you receive this message. The system 
then places calls to all of the designated conference participants 
(including yourself). Answer this call to start the multipoint 
videoconference. 

If you have not enabled ISDN Callback, the call connects as a regular 
multipoint call, based on the configuration settings. For more 
information, refer to the iPower collaboration application online help.  

Software Configuration 
 If the Port Ranges are set incorrectly, the iPower system will crash. For 

information on setting the Port Ranges, start AdminTools and access the 
online help topic Configuring the Adaptor/NAT/Port Range.  

 If QoS is enabled, calls through a D-Link NAT (model DI-704P) may not 
work.  

 If the system is configured with an incorrect NAT address, LAN calls 
have no video.  

 RSVP is not supported on iPower systems using the Windows XP 
operating system. 

 If you have upgraded to iPower version 5.0 software from a previous 
release, you must install Microsoft's QoS Packet Scheduler in order for 
the iPower system's QoS features to work properly. Note that the QoS 
Packet Scheduler has already been installed on systems pre-installed 
with version 5.0 or 6.0 software.  
To install QoS Packet Scheduler: 

1. Click Start and then choose Settings > Network and Dial-up 
Connections > Local Area Connection. 

2. Click Properties. 

 



3. Select Internet Protocol (TCP/IP) and click Install. 

4. Select Service and click Install. 

5. Select QoS Packet Scheduler, and click OK. 

 When you use AdminTools to configure the system for a Maximum 
Bandwidth, the setting does not take effect until the system is restarted.  

 When you create a WebOffice, your first attempt to log on will be 
unsuccessful. You should be able to log on successfully with subsequent 
attempts.  

 When an iPower system configured to run on an asymmetric network is 
then reconfigured not to run on an asymmetric network, the maximum 
incoming bandwidths are changed.  Reconfigure these items to values 
appropriate for your environment.  

 After you exit the iPower collaboration application, either wait several 
seconds before starting AdminTools (in order to allow the application 
time to complete its shutdown procedure), or launch AdminTools while 
the application is still running. (AdminTools automatically coordinates 
shutdown of the iPower collaboration application.)  

 In AdminTools, changes to incoming call bandwidth can cause the 
iPower system to lose its gatekeeper settings.  
To address this issue, do the following: 

1. Start AdminTools and click  LAN. 

2. Click the LAN Bandwidth tab. 

3. Change the incoming call bandwidth, and click Apply. 

4. To force AdminTools to save the change, click the Gatekeeper 
Setup tab, and then click the LAN Bandwidth tab. 

5. Click OK.   

 Do not enable Internet Connection Sharing in the Windows Network and 
Dial-up Connection settings.  

 The default audio algorithm for Internal Multipoint calls is G.722. Since 
calls to endpoints that do not support G.722 fail, you must change the 
audio algorithm to G.711 if there are NetMeeting or ProShare® systems 
on the network. Change the audio algorithm for Internal Multipoint calls 
in AdminTools>Internal Multipoint.  

 You cannot change the community string for SNMP to a blank value. If 
you do, the previous value is restored when you restart the system.  

 The iPower system registers properly with an ILS server running 
Windows NT, but does not register with an ILS server running Windows 
2000.  

 To disable RAS on an ISDN line previously configured for RAS, first 
uncheck the Use this line for network management via RAS check 
box in the ISDN Bandwidth tab in AdminTools, and then select None.  
If you do not do this first, RAS remains enabled even though the field is 
grayed out. The system may continue to reserve the line for RAS and it 

 



will not be available for video calls.  

 When you register the system to a RADVISION gatekeeper, you may 
receive a message that says “Failed to Ping the gatekeeper.” Ignore this 
message.  

 This release supports the Auto ISDN feature for systems in North 
America. Since not all network equipment supports Auto ISDN, you 
should manually configure your system if Auto ISDN cannot determine 
the network configuration. 

 If the system is configured to allow users to redial numbers, it retains 
the last number dialed until you log off. If you do not want to save the 
last number dialed, use AdminTools to disable this feature. 

 You must restart the system after you change the IMUX call mode using 
AdminTools.  

 Systems configured for V.35/RS-449 do not publish their information to 
the Central Directory. The system administrator must add this 
information manually. 

 iPower and TeamStation systems use different formats for their local 
directories. You cannot copy a directory file from a TeamStation to an 
iPower system or from an iPower system to a TeamStation. 

Logging On and Logging Off 
 iPower 900 systems running Windows XP operating systems may 

periodically require user intervention upon system shutdown. Should the 
system stall at the point where it would normally display the message, 
“It is now safe to turn off your computer”, you may safely power off the 
system by pressing the power button to the OFF position. 

 iPower Collaboration software supports users who are members of the 
following Windows groups: Users, Power Users or Administrators. Users 
logged in as “Guest” may be restricted from accessing certain iPower 
menu options. 

 You may experience problems if you change the Auto Logon user 
information on a system that is already set up for Auto Logon. To 
modify Auto Logon user information, configure the system to use 
Standard Windows Logon. Then, configure the system to use Auto 
Logon again. 

 Make sure you allow the iPower system time to complete its normal 
shutdown procedure. Do not click the End Now button on the Ending 
Application dialog box while the application is still running.  

Audio 
 The mixer panel for the virtual audio driver on iPower 9000 systems 

does not include a master volume control. You must enable the master 
volume control on the mixer panel. Do the following: 

1. Click the  Speaker icon in the System Tray and select Open 
Volume Controls.  

 



2. Select Options > Properties. 

3. Select the Playback option. 

4. Check the Volume Control check box. The Master Volume Control 
appears in the mixer panel.  

 For best results, always use Automatic as the preferred Audio 
Algorithm. 

Video 
 iPower 900 systems running Windows Media Player version 9.0B may 

experience system crashes when playing .AVI files. If this happens, 
follow these steps: 

1. From Windows Media Player, choose Tools > Options and 
then click the Performance tab. 

2. Move the Video Acceleration slider to the None position. 

 Avoid changing laptop screen resolution while it is the active Content 
source. 

 For best results, always use Automatic as the preferred Video Algorithm. 

 When you change the video display resolution, shut down the iPower 
collaboration application, change the resolution setting, and then restart 
the iPower system.  

 The supported resolutions for main display of the iPower system are 
800x600 and 1024x768 pixels. The maximum supported refresh rate is 
75 Hz.  

 To use the 32-inch XGA monitor at 1024x768 pixels, set the display to 
60 Hz. 

 When using a laptop or PC as a Content source, the following modes 
display valid video if the laptop or PC conforms to VESA standards: 

640x480, 60 Hz 800x600, 56 Hz 800x600, 75 Hz 
640x480, 72 Hz 800x600, 60 Hz 1024x768, 60 Hz 
640x480, 75 Hz 800x600, 72 Hz 1024x768, 75 Hz 

If the setting does not conform to VESA standards, the image may not 
display. Note that some unsupported modes may display on the laptop 
thumbnail if they approximate a supported VESA standard.  

Recording 
 When you record a meeting: 

– All audio is recorded. 

– On systems using a single monitor, everything on the monitor is 
recorded (both People and Content). 

– On systems using dual monitors, if a Content source is being shown, 
it is recorded. If no Content is being shown, far-end video is 
recorded. 

 The system may not display VCR video while fast-forwarding a tape.  

 



 Some VCRs may not appear on the People and Content list unless they 
are playing a tape. You can use AdminTools to configure the system to 
include the VCR on the People and Content list, even if no signal is 
detected. 

 When using the Digital Conference Recording feature on iPower systems 
with Windows XP, a “Browse for Folder” error message may appear 
when attempting to select the folder destination for the recorded 
stream. If this happens, click OK in the error message window, and 
select a new folder location from the screen that follows. 

Calling 
 When the iPower system is showing Content in a non-Dual Images call, 

the iPower system cannot adjust its People camera. The iPower system 
can only control a camera that is displaying video.  

 In this software version, you cannot make 2x64 non-dialed (DCE-
signaled or DCE-dedicated) calls.  To address this issue, place 1x128 
calls instead. 

 In a multipoint call that includes the ViewStation FX, the iPower system 
cannot control the presenter’s camera  

 During a call, you may experience substantial delays in T.120 activities 
when the far end takes control. 

 To make a loopback call, select a rate less than or equal to the number 
of ISDN lines connected.  

 When you are in a loopback call, the system does not allow you to select 
the Content source. 

 Conference Statistics and Operating Statistics may report a video error 
when you add or remove Content from a videoconference. This does not 
affect the quality of the call.  

 The iPower system does not transmit video in an H.263 ISDN QCIF call 
to a PictureTel Concorde•4500. To address this issue, set the resolution 
on the Concorde to CIF.  

 If an iPower system receives a still-image graphic from another type of 
system, the iPower system displays the graphic until the end of the call.  

 If an iPower system receives a still-image graphic from another type of 
system and you switch the image from the main video window to the 
PIP, the PIP displays a black screen.  

 Use a voice alias or E.164 address when placing Voice over IP (VoIP) 
calls. Encourage callers to do the same. Otherwise, the system may 
treat an incoming or outgoing call as a video call (for example, it may 
automatically answer the call if you configured auto-answer for video 
calls).  

 If a call is sent through a gateway or MCU that does not support People 
and Content, the Content video quality is reduced, even if both 
endpoints support People and Content.  

 Configure a gatekeeper before attempting to make gateway calls.  

 



 In a PathNavigator Conference on Demand call, only the local system is 
included in the Conference Sites list. To include all sites, enable Chair 
Control on the MCU.  

 Conferences hosted by an Avaya MCU do not support the Browse 
function.If you select Remote Control > Far-End Camera and turn off 
Picture-in-Picture (PIP) from the iPower collaboration application Options 
menu, you are unable to switch to near-end camera control.  

 When using an Ezenia! H.323 MCU, the call does not connect when 
dialed with an E.164 address that starts with the digit “1”.  

 When you use the on-screen Camera Controls, you cannot use the on-
screen cursor for functions outside of the Camera Controls, such as 
muting. You can use the buttons on the remote control or a keyboard 
shortcut.  

 A call must be at least 112 kbps to send Content. The system does not 
send Content in a 56 kbps or 64 kbps call.  

 If you attach V.35/RS-449 cables to the system when it is powered on, 
the system may interpret any signal changes as an incoming call. To 
address this issue, power off the system before connecting the cables.  

 In a V.35 DCE-Signal call to a Concorde•4500 system, the iPower 
system may hang up the call and not reconnect. To address this issue, 
configure the iPower system for DCE-Dedicated calls when placing or 
receiving non- dialed calls from a Concorde system.  

 In V.35 DCE-Signal calls, a Montage system does not disconnect 
properly from the iPower system. To address this issue, configure the 
iPower system for DCE-Dedicated calls.   

 Use the following encryption type settings with the call modes listed 
below. All other settings are invalid:  

Encryption Type  Call Mode 

KG-194 DCE-Signal 
DCE-Dedicated 

KIV-7 Dialed 

None Dialed  
DCE-Signal 
DCE-Dedicated 

 

 If you are using encryption in a DCE-Dedicated call, the call may take 
up to one minute to completely disconnect from the system.  

 iPower does not support these types of 2x64 calls:  
– 2x64 calls where both channels are dialed simultaneously 

– Non-dialed (DCE-signaled or DCE-dedicated) 2x64 calls 

 Dialed V.35/RS-449 2x64 calls may take up to 20 seconds to receive 
remote video.  

 On 900 or 9000 systems (V.35 or RS-449) using a Lucent/Ascend IMUX 
in Dialed mode, the IMUX may sometimes get into a state where it 
cannot place or receive 2x64 kbps or 2x56 kbps calls. If this occurs, 

 



access the IMUX through its console and force it to disconnect its second 
port. For information on how to do this, refer to the IMUX 
documentation.  

 Note the following when using a PT-235 adapter: 
– A V.35/RS-449 system operating with a PT-235 adapter that is 

configured for KIV-7 compatibility may experience delays or 
problems when disconnecting from a call. Configure the PT-235 
adapter to hang up the call if it loses synchronization for a specified 
time period. Refer to the PT-235 documentation for information.  

– The iPower system does not support restricted call rates when using 
a PT-235 adapter.  

– The iPower system does not support constant-carrier V.35/RS-449 
(DCE-Dedicated) calls to Montage when using a PT-235 adapter.  

– The iPower system does not support connecting a Quad-BRI to both 
a PT-235 adapter and a network/PBX ISDN line. For this reason, you 
cannot use the fourth ISDN BRI line when the system is connected 
to a PT-235 adapter.  

– If you are placing a call through a PT-235 adapter, perform the 
following steps to ensure that the call profile matches the call profile 
in the IMUX.  

1. From the iPower collaboration application, click Make a Call. 

2. Enter the appropriate setting for your IMUX type: 

IMUX  Setting Example 

Promptus #Call Profile**Video Number #60**95551731  

(384 kbps call with 
a call profile of 60) 

Lucent #Call Profile Video Number #01095556789 

(384 kbps call with 
a call profile of 010) 

 

3. If you need to select the call rate, click Advanced. 

 The iPower system is pre-configured with IMUX call modes that are used 
to dial common rates with the Lucent Multiband IMUX or the DICA Oasis 
IMUX. If you request a rate that is not configured, the system dials the 
next lowest rate. To dial at a rate that is not pre-configured, you can 
either provide the information when you dial the call, or set the IMUX 
type to Other in AdminTools, then configure the rates to support.  

 When you use iPower Control Protocol to dial a call, attempting to dial 
more sites than your license allows causes black video. 

 The iPower Control Protocol EncoderSourceChange and 
EncoderActiveChange events do not work correctly in this version of the 
iPower software.  

 Using the iPower Control Protocol commands SDPd and SDPv to select a 
Document Camera or VCR does not display the correct video.  

 



 When you use iPower Control Protocol to make calls from a LAN system 
to an ISDN system:  
– All prefixes and suffixes required by the gateway must be configured 

through AdminTools 

– The iCP Command must set the Calltype to Gateway. 

Internal Multipoint Option 
 The Internal Multipoint option uses several features that most gateways 

do not implement, such as flow control. As a result, Internal Multipoint 
calls through a gateway may fail to connect or may experience various 
problems, such as black video. 

Note: Internal Multipoint calls through gateways do not support 
Continuous Presence. 

 All participants in an Internal Multipoint conference must support G.722. 
If any do not, you must change this algorithm to G.711 using 
AdminTools. Do the following:   

1. Start AdminTools and click  Internal Multipoint. 

2. In the Audio Algorithm field, select G.711. 

 You must restart the system after you activate the 12-site Internal 
Multipoint option.  

 You cannot make an Internal Multipoint call using ISDN. If you try to do 
so, you receive an error message. To place an ISDN call, make sure the 
Allow additional video sites check box is unchecked.  

 When a site that does not support People and Content joins or leaves a 
call, other sites that support People and Content may briefly receive 
black video while People and Content is being enabled or disabled. 

 The Polycom ViewStation briefly displays distorted video when an iPower 
system leaves a videoconference. 

 On occasion, one may see the "Allow additional video sites" checkbox 
grayed-out after configuration changed related to Internal Multipoint.  
To work around this issue, restart the system. 

Using a RADVISION Gatekeeper on an iPower System with 
Internal Multipoint 

In order to use a RADVISION gatekeeper on an iPower system with 
Internal Multipoint, you must register the iPower system with the 
gatekeeper. Do the following: 

1. Use AdminTools to register the iPower system with the gatekeeper. 

2. On the gatekeeper, use the following configuration tools to locate 
the entry for the iPower system:  

o Use OnLAN on the L2W-323. 

 



o Use the web browser on the ECS to access the administrator 
page. 

3. On the gatekeeper, specify that the iPower system is Predefined, and 
save your change. 

4. Add a predefined endpoint on the gatekeeper with the following 
properties: 

Set this property: To this value: 

Type MCU 

Registration IP IP address of the iPower system 

Forward to Leave blank 

Port 1701 

Type Use the default setting 

Alias Conference@name of the iPower system 

Alias Type Name 

Allowed Services All services allowed 

Note: After registering the system with the gatekeeper, wait several 
minutes before making calls with the iPower system. 

WebRemote 
 You cannot use WebRemote to place an Internal Multipoint call. 

 When you use AdminTools to disable WebRemote and then re-enable 
WebRemote, you must restart the system before you can use 
WebRemote.  

 After making changes to the Network Management settings, you must 
either restart the iPower system or uncheck and check the Allow 
management via SNMP check box to force the system to save the changes 
immediately.   

 To display WebRemote statistics charts, configure SNMP with a 
community string of public.   

 If you are using WebRemote, you will not see any changes made to the 
system configuration using AdminTools during your WebRemote session. 
You must exit and restart WebRemote to see the changes.   

 If you use WebRemote on a Chinese or Japanese system, and you select 
a language other than Chinese, Japanese, or English, some WebRemote 
pages (such as those with accented characters) may not display 
properly.  

 Use Internet Explorer 5.0 (or higher) or Netscape® Navigator 4.06 (or 
higher) when using WebRemote. 

 To view the Alarms and Statistics pages, you must configure your web 
browser to use Microsoft Java runtime. Perform the following steps:  

 



1. From the web browser, select Tools > Internet Options and click 
Advanced. 

2. Uncheck the check boxes for any other Java plug-ins.   

Note: Netscape Navigator 6.0 does not display the Alarms and Statistics 
pages.  

 You cannot save system configuration changes made using WebRemote 
if Auto Logon is enabled and the Auto Logon password is blank. You 
must change the Auto Logon name and enter a password. 

Hardware 

The iPower system is tested extensively with the hardware configuration 
supplied as standard with this system. Polycom cannot warrant the 
operation of the system if you replace or add your own hardware. Unless a 
separate maintenance contract is in place, our technical support personnel 
may request that you replace the original hardware to be able to 
effectively isolate any problem. Please note that the software supplied to 
install the operating system and the iPower collaboration software will not 
reflect any user-installed hardware. 

 In some environments, the drivers for iPower 9000 system’s Network 
Interface Card may spontaneously uninstall.  If this occurs, download 
the new version of this the driver from Intel's web site. 

 If the Low Cost BRI card is replaced with another Low Cost BRI Card, 
the ISDN Bandwidth settings are automatically set to 64K and all calls 
are restricted to 64K. To make higher bandwidth calls, manually reset 
the standard and premium bandwidths to a higher setting. 

 When you power on an iPower 9000 system with an iPower 70 camera, 
the camera may take a few minutes to fully initialize. During this time, 
you may see a camera readiness message. You do not need to take any 
action. After the start-up period, the message disappears and the 
system is ready to use. 

 The DVD drive in the iPower 9000 system reads CDs and data DVDs, 
but it does not play video DVDs. If you try to install the software 
required to play video DVDs, it may conflict with the iPower system’s 
video drivers. To address this issue, connect an external DVD player to 
the iPower 9000 system just as you would connect a VCR.   

 On the iPower 9000 system, the VGA monitor connector labeled Monitor 
3 (the second VGA output) is not supported.   

 When using a Hitachi™ CMP307XU or other native XGA display device, 
change the resolution of the iPower system to 1024x768 for better 
display quality.  

 If you are using any USB device, you must obtain and install the latest 
Windows 2000 drivers from the manufacturer’s web site. 

 



 If you ordered the iPower system with PN 370-1214-02 V.35/RS-449 
board, make sure that you use the correct jumper settings and the 
appropriate cable.  
– This board supports both V.35 and RS-449, depending on how you 

set the J3 jumper.  

If you use: Set jumper J3 to: Use this cable: 

V.35 Pins 2 and 3 180-0339-01 

RS-449 Pins 1 and 2 180-0340-02 

– This board also ships with support for the KG-194 encryption device 
enabled. To enable support for the KIV-7 encryption device, set the 
J2 jumper setting as shown in the table below.  

If you use: Set jumper J2 to: 

KG-194 encryption Pins 1 and 2 

KIV-7 encryption Pins 2 and 3 

 The new iPower 9000 remote control and keyboard use infrared (IR) 
signals that operate at a frequency of 38.4 kHz and a wavelength of 
940 nm. The iPower 600/900 remote control uses IR signals that 
operate at a frequency of 38 kHz, 880 nm. The older iPower 600/900 
keyboard and trackball use IR signals that operate at 56 kHz, 950 nm.  
On rare occasions, room lighting may interfere with these signals, which 
could reduce the range of the devices or render them inoperable. If you 
encounter this situation, do one or more of the following: 

– Decrease the room lighting. 

– Change lighting and ballasts to a frequency outside of the range 
used for the Polycom devices. 

– Use a hard-wired or radio-frequency (RF) keyboard. 

iPower Applications 
 The following objects in the iPower SNMP MIB do not implement the 

Write operation, even though the MIB specifies them as Read-Write: 
– ptConfSysDescription 

– ptConfSysNotificationMode 

– ptConfSysName  

– ptConfSYSOID  

– ptConfSysUpTime 

– Objects in the Advanced Configuration 

Write operations against these objects appear to complete 
successfully but do not actually change anything. 

In addition, the MIB-II object ptConfSysName does not implement 
the Write operation. Write operations against it appear to complete 
successfully but do not actually change anything. 

 



 After you restart the system, you may see an error message the first 
time you access the iPower collaboration application online help. Click 
Yes to continue.  

 You must restart the iPower system after running the Hardware 
Diagnostics application. 

Third-Party Applications 

The iPower system is tested extensively with third-party software. Polycom 
attempts to address compatibility issues with all third-party applications for 
which the operating system, CPU, and memory are appropriate. However, 
incompatibilities may arise due to the complex nature of a multimedia 
collaboration system. In the event that an incompatibility issue arises, 
Polycom technical support may request that you uninstall a third-party 
application in order to isolate the problem. 

The following applications are pre-installed on the iPower system:   

 Microsoft Internet Explorer (IE) Version 6.0 with Service Pack 1 

 Microsoft Word Viewer 97 

 Microsoft Excel Viewer 97 Version 8.0 

 Microsoft PowerPoint Viewer 97 Version 8.0 

 Microsoft NetMeeting Version 3.01 

 Adobe Acrobat Reader Version 5.0 

The iPower system has been tested and found compatible with the 
following third-party applications.  

 Microsoft Office XP 

 McAfee VirusScan Version 4.5.1 

 PCAnywhere Version 10 (configured for Legacy video mode) 

 WinZip Version 8 

 Adobe Acrobat Version 5.0 

Note: This list is not a complete inventory of compatible applications; it 
simply indicates the applications that have been tested for 
compatibility. 

Be aware of the following application-related restrictions in this release: 

 Do not use Windows Update to update the drivers for the Savage video 
chipset. Polycom provides a customized video driver. Replacing the 
Polycom video driver may cause problems with iPower system video.   

 If you use NetMeeting Chat to send a message in a T.120 call, the 
NetMeeting Chat window does not pop up on the system receiving the 
message. You must maximize the window manually.  

 You must close the iPower collaboration application when running 
applications that utilize DirectDraw resources (for example, certain 
screen savers and video applications such as streaming viewers). 

 



 Internet Explorer users running Windows XP Service Pack 2 may 
encounter a “content blocking” security warning when attempting to 
view a live or recorded video stream in a browser window. If this occurs, 
continue to the next screen as prompted in the warning message 
window and select “Allow Blocked Content” to view the stream. 

Localization 

The translation for the [Near/Far] button on the Japanese-language 
versions of the iPower 9000 remote control and keyboard is inaccurate. 

The translation should read , instead of . This 
will be corrected in future versions of the remote control and keyboard. 

For information about the availability of the Japanese-language versions of 
the iPower 9000 remote control and keyboard, contact your Polycom 
service provider. For information about using the Near/Far button, see the 
iPower System help. 

 

Data Collaboration 
 When sharing applications in an iPower conference, annotations from 

the SMART Board™ interactive whiteboard can be written from both 
sites. From the remote site, these annotations can take several seconds 
to update back to the host site. This differential depends on the speed of 
your data connection. To address this issue, SMART Technologies Inc. 
implemented a Remote Local Update feature in the SMART Board driver. 
Remote Local Update allows remote sites to annotate and see the 
annotations instantly on their boards. Although these annotations are 
seen instantly at the remote sites, it actually takes them a few seconds 
to appear at the host site. The benefit of this feature is that the remote-
site annotations appear to be updated instantly.  

 Calls placed with an Avaya, PictureTel Montage, or Ezenia! H.320 MCU 
do not support T.120.  

 T.120 is not supported in ISDN multipoint calls using PathNavigator 
Conference on Demand.  

 



 Data sharing is not available for calls made through a gateway to a 
PictureTel 330 MCU.  

 T.120 may not function properly in calls made through a gateway from a 
LAN system to an ISDN system.  

 Application sharing is significantly slower in ISDN calls than in LAN calls. 
If you do not need to allow the far-end to modify your document, you 
can address this issue by sharing your document as video using the 
ImageShare device, or by sharing the iPower system Windows Desktop.  

 An iPower system running software lower than Version 3.0 (or any other 
system that uses NetMeeting Version 2.11 as its data collaboration 
engine) cannot collaborate on applications that are shared by an iPower 
system running Version 3.0 software or higher. 

 When a far-end site stops sharing an application via T.120, the sharing 
window may remain on the screen and hide the far-end window. To 
address this issue, minimize the application-sharing window to bring the 
iPower collaboration application and video to the foreground.  

 Sharing an Adobe® Acrobat® file may cause the system to freeze if the 
far end tries to take control. To address this issue, hang up the call and 
redial.  

 To ensure that all participants see the same region of a shared 
application, set up all systems with the same resolution whenever 
possible.  

 If you change the system’s configuration to allow T.120 calling, you 
must reboot the system before the change takes affect before you can 
make calls to a ViewStation or ViewStation FX.  

Additional Information 
If you need further assistance with your system, you can refer to these 
resources: 

 For help with ordering ISDN or with setting up your LAN for 
collaboration, see Preparing Your Network for Collaboration, available on 
the iPower Documentation CD or from the Polycom web site at 
www.polycom.com. 

 For help with administrator tasks, see the AdminTools online help or 
refer to the iPower Collaboration System Tips and Troubleshooting 
Guide, available on the iPower Documentation CD or from the Polycom 
web site at www.polycom.com. 

 For the latest information and updates, use your web browser to go to  
www.polycom.com. 

 When sending error log files to Polycom, compress them with the WinZip 
application. To download the most current evaluation copy of this 
software, go to www.winzip.com. You may also order a full copy of WinZip 
at this site. 

 



Installing Version 6.2 Software on the iPower 
Systems 

This section describes how to upgrade the 6.2 software on the iPower 600, 
900, and 9000 systems.  This section also describes how to reinstall the 
6.0 software on iPower 9000 systems. 

After upgrading 6.2 software, Polycom recommends that you go to 
extranet.polycom.com for any 6.2.x maintenance updates. 

Installing Version 6.2 Software on the iPower 600 
System 

For iPower Release 6.2, you can upgrade the iPower 600 system software 
by downloading iPower_6_2_0_Update.exe from the Polycom Web site 
(extranet.polycom.com). 

You can apply iPower Version 6.2 software to your system only if it is 
running software Version 5.x or higher. If your system is running an earlier 
version, upgrade it to 5.x before you begin. 

Before You Upgrade the iPower Software 

Before you upgrade the iPower software to Version 6.2, make sure you do 
the following: 

1. Log on to the system with an account that has administrative rights.  

If your system is set up for Auto Logon, use AdminTools to configure 
the system to use Standard Windows® Logon, and restart the 
system. See the iPower Collaboration System Tips and 
Troubleshooting Guide for details. 

2. Download the software from the Polycom Web site 
(extranet.polycom.com) to your local drive. On an iPower 600 
system, you must download the software to the D: drive. 

3. Ensure that you have at least 195 MB of free space on both the C: 
and D: drives.  

To free up space on these drives, consider the following measures: 

– Delete Temporary Internet Files:  

o To display these files, from Windows Explorer, choose 
Tools>Folder Options. Click the View tab and select Show 
Hidden Files and Folders.  

o To delete these files, start Internet Explorer and select 
Tools>Internet Options. In the Temporary Internet Files 
section, click Delete Files. You can delete these files for each 
system user. The files are stored in C:\Documents and 

 



Settings\<username>\Local Settings\Temporary Internet 
Files. 

– Delete files in the C:\Documents and Settings\ <username>\Local 
Settings\Temp directories. 

– If you have installed any Win2K service packs, do the following: 

o From Windows Explorer, choose Tools>Folder Options. Click 
the View tab and select Show Hidden Files and Folders.  

o Delete or move to the D: drive any folders under C:\WINNT 
that have a name starting with $NtUninstall followed by 
several additional characters. This could free up 7 to 8 MB. 

– Delete any large .dmp files from C:\Documents and Settings\All 
Users\Documents\DrWatson\. 

– Reduce the size of the paging file on the C: drive. To do this: 

o From the Windows Desktop, right-click My Computer, then 
click Properties. 

o Click the Advanced tab. 

o Click Performance Options. 

o Click Change…  

o For the C: drive, set the initial and maximum size to 8 MB. 

o Click OK until the computer reboots. 

– If any of these files are large, you can delete them to free significant 
space: 

o C:\iPower_install.txt 

o C:\iPower_install.log 

o C:\sapi_install_log.txt 

o C:\DpProcessor0.txt, C:\DpProcessor1.txt, 
C:\DpProcessor2.txt, C:\DpProcessor3.txt 

o “C:\winnt\Windows Update Setup Files” and all files and 
subfolders 

– Empty the Recycle Bin. 

4. Close all Windows applications, including any anti-virus software. 

Upgrading the iPower 600 System Software 

This section contains information about upgrading your iPower 600 system 
software to Version 6.2. 

1. Double-click iPower_6_2_0_Update.exe to start the upgrade, and 
then follow the instructions on the screen. 

2. Restart the system to complete the upgrade. 

3. Polycom recommends that you go to extranet.polycom.com to check 
for any 6.2.x maintenance updates. 

 



Installing Version 6.2 Software on the iPower 900 or 
iPower 9000 System 

For iPower Release 6.2, you can upgrade the iPower 900 or 9000 system 
software by downloading iPower_6_2_0_Update.exe from the Polycom 
Web site (extranet.polycom.com). 

Note: You can upgrade to iPower Version 6.2 software only if your 
system is running software Version 5.x or higher. If your system 
is running version 3.x or 4.x, you must first upgrade to version 
5.x and then upgrade to 6.2. If you have version 2.x or earlier 
(which uses Windows NT as its operating system), you must 
reinstall the iPower software since Version 5.0 uses Windows 2000 
as its operating system. See the section “Reinstalling the iPower 
900 or 9000 System Software” for more information. 

 To reinstall the iPower 900 system software to version 5.0, use the boot 
floppy and the two-CD set with part numbers 5151-50783-001/A  and 
5151-50784-001/A (model number 2200-51032-001).  After doing this, 
you will still need to upgrade to 6.2. 

 To reinstall the iPower 9000 system software to version 6.0, use the 
two-CD set with part numbers 2151-50356-003/A and 2151-50357-
003/A (model number 2200-51033-001). 

Before You Upgrade the iPower Software 

Before you upgrade the iPower software to Version 6.2, make sure you do 
the following: 

1. Log on to the system with an account that has administrative rights. 

If your system is set up for Auto Logon, use AdminTools to configure 
the system to use Standard Windows Logon, and restart the system. 
See the iPower Collaboration System Tips and Troubleshooting Guide 
for details. 

2. Download the software from the Polycom Web site 
(extranet.polycom.com) to your local drive. 

3. Ensure that you have at least 195 MB of free space on the C: drive.  

4. Close all Windows applications, including any anti-virus software. 

Upgrading the iPower 900 or 9000 System Software 

This section contains information about upgrading your iPower 9000 or 900 
system software to Version 6.2. 

To upgrade iPower 900 or 9000 system software 

1. Double-click iPower_6_2_0_Update.exe to start the upgrade, and 
then follow the instructions on the screen. 

 



2. Restart the system to complete the upgrade. 

3. Polycom recommends that you go to extranet.polycom.com to check 
for any 6.2.x maintenance updates. 

Note: After upgrading an iPower 9000 system to version 5.3.0 or later 
software from 5.1.0 or earlier software, you are prompted to 
reboot the system again. Be sure to perform the requested 
reboot.  You will need to do this for locally-applied updates as well 
as for updates performed via WebRemote or the Global 
Management Server. 

This “extra” reboot occurs the first time a system updates from 
5.1.0 or earlier software to 5.3.0 or later software; it will not be 
required for future updates. 

Reinstalling the iPower 9000 System Software Version 
6.0 

When you reinstall the iPower Version 6.0 system software, all of your 
system settings, Directory entries, and other user files are overwritten. 

1. Back up local directory data. 

Save your Local Directory data by copying  
C:\Program Files\PictureTel\vcs\tsdir.ini to external media. 

2. Record configuration settings. 

Make a record of your configuration settings by running the Polycom 
Operating Statistics utility. On the Configuration Summary page, 
click Save As to save the iPowerSysConfigLog.txt file to external media. 
You can use this information to help reconfigure the system after the 
upgrade. 

3. Make sure you have the iPower 9000 system serial number and your 
LAN and ISDN settings. 

4. Insert the CD marked Disk 1 of 2 into the CD-ROM drive, and then 
power on the system. 

A warning screen appears. Press Enter to continue. 

5. Insert the CD marked Disk 2 of 2 when you see this dialog box:  

 

Press Enter after you insert the second CD. 

 



6. Follow the instructions on the screen, and restart the system to 
complete the upgrade.  

If the system does not restart automatically after completing the 
upgrade, you must restart it manually.  

During installation, a “0x0B Read Default” error message may appear, 
along with Abort and Retry buttons. Since the mouse is inactive at 
this point, press Enter to continue the installation process.  

7. After installing 6.0 software, check extranet.polycom.com for any 
6.x maintenance updates. 

 

 


